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Chapter 1 : Outlook Basic Training: Information Technology - Northwestern University
Course Introduction In this manual you will be learning basic and advanced topics in Microsoft Office Outlook Microsoft
Outlook is a program for E-mail, contact and scheduling management, use of the Calendar feature and more.

Matt Klein December 2, , A typical company can connect Outlook to an Exchange server, and everyone can
share the same address book and calendars, making it a great tool for enterprise level collaboration. Unlike
other popular Office apps, however, Outlook is largely built around its different functions â€” Word is
primarily for creating text documents, Excel is all about spreadsheets, PowerPoint does presentations â€” but
Outlook is a app of many hats. Love them or hate them, Ribbons are everywhere throughout Office. If you
click on any of the menu functions at the top, the Ribbon shows and you can choose functions and tools. In the
above screenshot, we see our options for Mail. Along the left edge, you see the folder pane. In this example,
you see icons for the Inbox, Calendar, People, Tasks, and so on. If you click on the arrow at the top of
navigation pane, it will expand the pane, which will display the folder tree for your email account. Similarly, if
you switch to the Calendar mode, you will see the applicable view in the folder pane. Click on the three dots
to access further Outlook modes, such as Notes, Folders, and Outlook shortcuts. You can also increase or
reduce how many items appear and the order they appear. Folder Overall, the Folder tab is fairly consistent
across all modes, with the notable exception of the Calendar. As we mentioned, most of the Folder tabs are
fairly consistent throughout Outlook, except the Calendar, which caters to calendar-specific functions. View
The View options contain the following essential functions. This is the View tab as seen from the Inbox. If
you had any reminders showing, you could choose to dismiss each one, hit the snooze button, or simply
dismiss everything in one go. The other View tabs will vary according to the mode. The following is attributed
to the Calendar, which adds the ability to change the current view, arrangement, color, and layout. Notice how
you can sort and change the Tasks view for maximum impact. Using the View tab per your preferences will
allow you to cut through and sort information quickly as it increases and builds over time. Compare that to the
Task Ribbon, which is accessible by starting or opening a task. Take a moment to note just how different it is
from the Message Ribbon. Compare that to the Insert tab. Email messages do add an Options tab, which have
quite a few useful features. This tab bears a striking resemblance to the formatting functions found in Word, so
if you use Word to write and format documents, these controls will likely be familiar to you. Notice also that it
contains Language functions, here you can set your language preferences and proofing preferences. You can
also translate items such as if you correspond with a foreign partner or someone sends a bit of text in another
language. Obviously, we skipped over a lot of specifics, but we feel that once you understand the nature of the
Ribbon system. When you want to use a function, you know where to look for it. You have a choice, you can
set Outlook up immediately with an email account, or you can skip this part and add an account later. Of
course, you can still use it to track tasks, notes, keep a calendar, and other things, but Outlook is really an
email-centric experience. You can initially try to do so automatically, where you will enter some cursory
information about your account and the application will try to automatically detect the settings. If it does, then
you win, and you can skip ahead to the next section. If you need to set up an account manually, we suggest
you skip ahead to that section. In the meantime, we simply used an Outlook. Thankfully, you can set up
Outlook to operate with many different email accounts including POP and IMAP, and you can have as many
accounts as you can personally handle. POP is great for downloading your messages. Like we said, we think
IMAP is the far superior method. That is to say, if you use Gmail or Yahoo! Once you have added your
accounts, if you ever need to manage them you can choose the account you want to deal with from the
drop-down selector at the top of the Account Information page found on the File tab. From the resulting
window, you can create a new account, repair a current one, remove it, set it as default if you have more than
one and, of course, change any settings if necessary. Here we see the settings for an Outlook. Remember, you
only have to do this kind of stuff once, and then forget it. While you may be satisfied using just Gmail or just
Yahoo! Once your email accounts are set up and ready, you can start using Outlook and exploring all of its
functions.
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Chapter 2 : The Beginnerâ€™s Guide to Microsoft Outlook
2 Outlook User Guide Office Integration the Mail Folders area in Tips & Tricks: Drag & Drop messages to the calendar,
contacts, tasks, notes, etc.

We do not recommend this setting. We recommend turning on two-factor authentication and using an app
password. To turn on two-factor authentication and get an app password, use the following steps. Otherwise,
skip to step 4. Enter your phone number and select whether you want to receive your verification codes by text
message or a phone call. Enter the code you received and click NEXT. Return to the previous screen by
clicking the left arrow at the top of the screen next to 2-Step Verification. Enter your Google password and
then select Sign in. At the bottom of the next screen, select Mail and Windows Computer from the drop-down
lists, then select Generate. Google will display an app password for you. Copy this password without the
spaces and enter this password when Outlook prompts you for a password. You may need to sign in again.
Then select Manage app passwords. Select Outlook Desktop from the drop-down list, and then select
Generate. Yahoo will display an app password for you. Enter this code to continue. Otherwise, turn on
two-factor authentication. Enter a name for your password, such as Outlook, and select Create. Apple will
display an app password for you. Add a new account quickly Most email accounts, including Office ,
Exchange server accounts, Outlook. Click Allow to continue. If you are adding Gmail, you will get a prompt
within Outlook to sign-in to your Google account. This is for users who are on Build Have you already added
your Gmail account to Outlook then see, Improved authentication for existing Gmail users. Select Done to
start using Outlook for Mac. If you have a Google account added to Outlook for Mac earlier to the release of
improved authentication experience for Google IMAP accounts, then you will need to sign-in using the
browser to connect to your account. Select Sign in to Google. You will be asked to allow Outlook to access
your mail, contacts, and calendars. You will be asked to return back to Outlook. Select the email account you
want to change. When finished with your updates, select OK. After your first account is set up, follow these
steps to add all subsequent email accounts. Enter the email address of the account. Follow the prompts to
complete the account setup. Set up two-factor authentication for Gmail Two-factor authentication is an extra
layer of security for your account. Enter this code to complete the sign-in. Select 2-Step Verification and
follow the prompts. Make a note of this password without the spaces and use this as the password when
adding a new account to Outlook.

Page 2

DOWNLOAD PDF MICROSOFT OUTLOOK 2007 USER MANUAL
Chapter 3 : User manual for Outlook - Microsoft Community
Microsoft Office Outlook User Guide Pdf Microsoft outlook wikipedia, microsoft outlook is a personal information
manager from microsoft, available as a part of the microsoft office suite although often used.

Such files are saved using an extra X letter in their extension. However, it can still save documents in the old
format, which is compatible with previous versions. Alternatively, Microsoft has made available a free add-on
known as the Microsoft Office Compatibility Pack that lets Office , XP, and open, edit, and save documents
created under the newer format. However, due to legal objections from Adobe Systems , Office originally did
not offer PDF support out of the box, but rather as a separate free download. This is part of Service Pack 2 and
prior to that, was available as a free plug-in in a separate download. OpenDocument software Microsoft backs
an open-source effort to support OpenDocument in Office , as well as earlier versions up to Office , through a
converter add-in for Word, Excel and PowerPoint, and also a command-line utility. Peter Amstein and the
Microsoft Office team are reluctant to make liberal use of extension mechanisms, even though provided in
ODF 1. They want to avoid all appearance of an embrace-extend attempt. User assistance system[ edit ] In
Microsoft Office , the Office Assistants were eliminated in favour of a new online help system. One of its
features is the extensive use of Super Tooltips, which explain in about one paragraph what each function
performs. Some of them also use diagrams or pictures. These appear and disappear like normal tooltips, and
replace normal tooltips in many areas. The Help content also directly integrates searching and viewing Office
Online articles. SharePoint[ edit ] Microsoft Office includes features geared towards collaboration and data
sharing. As such, Microsoft Office features server components for applications such as Excel, which work in
conjunction with SharePoint Services , to provide a collaboration platform. Excel server exposes Excel
Services, which allows any worksheet to be created, edited and maintained via web browsers. It features Excel
Web Access, the client-side component which is used to render the worksheet on a browser, Excel Calculation
Service which is the server side component which populates the worksheet with data and perform calculations,
and Excel Web Services that extends Excel functionalities into individual web services. SharePoint can also be
used to host Word documents for collaborative editing , by sharing a document. SharePoint can also be used to
hold PowerPoint slides in a Slide Library, from which the slides can be used as a formatting template. It also
notifies users of a slide automatically in case the source slide is modified. Also by using SharePoint,
PowerPoint can manage shared review of presentations. Any SharePoint hosted document can be accessed
from the application which created the document or from other applications such as a browser or Microsoft
Office Outlook. Groove[ edit ] Microsoft Office also includes Groove, which brings collaborative features to a
peer-to-peer paradigm. Groove can host documents, including presentations, workbooks and others, created in
Microsoft Office application in a shared workspace, which can then be used in collaborative editing of
documents. Groove can also be used in managing workspace sessions, including access control of the
workspace. To collaborate on one or more documents, a Workspace must be created, and then those who are
to work on it must be invited. Any file shared on the workspace are automatically shared among all
participants. The application also provides real-time messaging, including one-to-one as well as group
messaging, and presence features, as well as monitoring workspace activities with alerts, which are raised
when pre-defined set of activities are detected. Groove also provides features for conflict resolution for
conflicting edits. Schedules for a collaboration can also be decided by using a built-in shared calendar, which
can also be used to keep track of the progress of a project. However, the calendar is not compatible with
Microsoft Outlook. The Document Theme defines the colors, fonts and graphic effects for a document. Almost
everything that can be inserted into a document is automatically styled to match the overall document theme
creating a consistent document design. The new Office Theme file format. Similar themes are also available
for data reports in Access and Project or shapes in Visio. Quick Styles are galleries with a range of styles
based on the current theme. There are quick styles galleries for text, tables, charts, SmartArt, WordArt and
more.
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System is Win 7, 64 bit, with Outlook , email via POP server at ISP, no local Exchange server, and no Active Directory
available. Un-installed KB as noted above, voila! Archiving is back, changing folder is quick as the mouse click.

How to troubleshoot Outlook when you cannot send or receive e-mail Content provided by Microsoft Applies
to: The article outlines troubleshooting steps for Outlook , Outlook , and Outlook If you use an earlier version
of Outlook, refer to the "Similar problems and solutions" section for an article that pertains to your version.
This article is intended for a beginning to intermediate computer user. You may find it easier to follow the
steps if you print this article first. Before you begin troubleshooting, determine whether you can connect to the
Internet You should first try to determine whether you can connect to the Internet. If you are connected to the
Internet but you cannot send or receive e-mails, go to method 1 to create a new e-mail profile. If you cannot
connect to the Internet, this might be the reason that you are unable to send or receive e-mails. You might
want to contact your ISP. After your Internet connection is restored, try to send yourself an e-mail to check
whether your problem is resolved. If you are still unable to send or receive e-mails after your Internet
connection is restored, go to method 1. Create a new e-mail profile Video: How to create and configure an
email profile in Outlook Step 1: Depending on the version of Windows running on your computer, do one of
the following: If you are not in the Category View, double-click Mail. Click User accounts, and then click
Mail. The Mail Setup dialog box opens. Click Add to start the New Profile wizard. Follow the steps
appropriate for your version of Outlook: Microsoft Office Outlook Click to select the Manually configure
server settings check box. On the Choose Service page, click Internet E-mail. Fill in the boxes in the Internet
E-mail Settings dialog box. Click Next, follow the prompts to finish setting up your account, and then click
Finish. Your new profile is created. Go to step 4. On the Choose E-mail service page, click Internet E-mail.
Set the default profile On the Mail dialog box, under the When Starting Microsoft Outlook, use this profile
box, click to select the new profile that you created in step 3. Use Outlook to send yourself an e-mail. If you
successfully receive the e-mail, you have completed troubleshooting the problem. If you do not receive the
e-mail, creating a new profile did not resolve your problem. Note If you use Dial-Up Networking to connect to
the Internet, unfortunately, this article will not be able to help you further. Refer to the "Next steps" section for
additional options. Open the Network Connection Properties dialog box Depending on the version of
Windows running on your computer, do one of the following: Windows XP or Windows Click Start, and then
click Run. Click Start Type ncpa. Right-click your connection to the Internet, and then click Properties. Note
If more than one connection is displayed in the Network Connections window, the connection that you use to
connect to the Internet should say Connected or something similar. Click Yes if you are prompted to restart
your computer. If you do not receive the e-mail, unfortunately, this article did not help you. Similar problems
and solutions For a Microsoft Outlook version of this article, see For a Microsoft Outlook 98 version of this
article, see For a Microsoft Outlook 97 version of this article, see Next steps If these methods did not work
for you, you can use the Microsoft Customer Support Services Web site to find other solutions to your
problem. Search technical support information and self-help tools for Microsoft products. View
product-specific frequently asked questions and support highlights. If you continue to have problems with
sending and receiving e-mail in Outlook, you might want to contact Support:
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family members, Microsoft Office Outlook offers an ideal solution. Outlook integrates e-mail, address books, calendars,
task lists, note pads, and more into one.

Contains mail related folders like inbox and sent items folder. Use the Favorites section at the top of the pane
for easy access to frequently used folders Calendar â€” Lets you view and schedule appoints, events and
meetings, and compare calendars side by side. Tasks â€” Organize to-do lists, track task progress and delegate
tasks. Contacts â€” Store addresses, phone numbers, and e-mail addresses. E-mail Basics E-mail Basics: View
Tab Changing view of Reading Pane You can change the view of your Reading Pane on the screen, moving it
to the right or bottom of the screen. You can also turn it on an off. Click View in the Menu Bar. Click the
Right, Bottom or Off. You can also turn the Navigation Pane off. Click Normal, Minimized or Off. You can
also choose whether you want the favorites folders to show. You can select which features of the To-Do Bar
are visible and choose between Normal and Minimized views. You can also turn the To-Do Bar off. The new
e-mail window will open. Type the address of the recipient in the To Type an address in the Ccâ€¦ field if you
wish to send a copy of the message to a third party. Type a subject matter in the Subject field. Type your
message in the large text box. Auto-complete appears as soon as you start typing an address in the Toâ€¦ field.
Hit enter on your keyboard when the correct address is displayed and auto-complete will fill in the remaining
characters. It can help you find contact information and e-mail addresses, and can be accessed from the new
e-mail window. We will discuss the Global Address List in greater detail later in this guide. Type an
identifying piece of information, such as a last name, into the Toâ€¦ field. On your keyboard, hold the Ctrl key
down and hit the K key. The Check Names window will open. This window lists all matches from both your
personal contacts and the Global Address List. Click the record for the person you want to message. An e-mail
address for the person you want to message will appear in the Toâ€¦ field. Working with Folders Folders
provide a useful way to manage your messages. They appear in the navigation pane. You can create folders in
any structure that suits your needs. Right click on the folder that will house your new folder. Click New Folder
in the drop down menu. The Create New Folder window will open. Type the name of your new folder in the
Name field. Click in the Select where to place this folder field if you wish to change where your folder will be
located. The new folder will appear in the location you indicated. You can drag and drop messages directly to
this or any folder. Signatures Creating a Signature Outlook allows you to create custom signatures for your
messages. You may create multiple signatures to apply to messages as you see fit. Your first signature is
automatically applied as your default signature and will appear on your outgoing messages. Click
Signaturesâ€¦ in the drop down menu. The Signatures and Stationary window will open. Click New to create a
new signature. Type the name of your signature in the New Signature window that appears. Type your desired
signature in the text box below. Click Save to save your signature. Add additional signatures or Click OK to
exit. Inserting a Signature If you have created more than one signature, you can select which one you wish to
use while composing a new message. Open the New E-Mail window. Click Signature in the New E-Mail
ribbon. A list of the signatures you have created will appear in the drop down menu. Click on the signature
you wish to use. The signature will appear in at the bottom of your message. Calendar Basics Outlook has a
robust calendar feature for managing your time and scheduling meetings with other NU users. The calendar
will appear in the Outlook Screen. Adding an Appointment There are two ways to add an appointment to your
calendar: Click New Appointment in the Menu Bar. Select Appointment in the drop down menu. OR Double
click an area on your calendar. The Appointment window will open. Type a subject for your appointment in
the Subject field. Type a location for your appointment in the Location field. Set a start and end date and time
for your appointment. Type a note for your appointment in the large text box. Click in the Reminder field in
the ribbon to set a reminder for your appointment. Reminders can be scheduled for five minutes to two weeks
before the appointment. Your appointment will appear in your calendar. Adding a Meeting Request Meetings
differ from appointments in that a meeting allows you to invite attendees and reserve rooms and resources at
Northwestern. When you create a meeting request, invited users will receive an e-mail invitation to which they
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can respond. You will receive notification when users accept, decline or propose a new time for the meeting.
There are two ways to access the New Meeting window. Click on New Items in the Menu Bar. Click Meeting
Request in the drop down menu. The New Meeting window will open. Type a subject for your meeting in the
Subject field. Type a location for your meeting in the Location field. Type a note about your meeting in the
large text box. Click in the Toâ€¦ text box and begin typing the name or address of an attendee. Auto-complete
will suggest a recipient. Hit Enter on the keyboard to accept a suggestion. Type the name of an attendee in the
Toâ€¦ field. Hit Ctrl-K on your keyboard and select the attendee you want from the list that appears. Selected
attendees will appear in the Toâ€¦ field. Select a date and time for the meeting. Click Send to send the
invitation. Attendees receive an e-mail invitation to the meeting, and you will be notified if they accept or
decline. You have access to a Global Address List that contains everyone who has an NU e-mail address and a
Personal Address Book for contacts inside or outside of the University. To access the Global Address List:
Click Address Book on the right side of Menu Bar. The Address Book window will open. Type a name into
the search box. As you type, the search function will display possible matches. Click the name of the person
for whom you are looking. Click Add to Contacts to add them to your personal address book. A new window
will pop up. Click Save and Close. They will appear in your Personal Address Book.
Chapter 6 : Add an email account to Outlook - Office Support
microsoft office suite resources Villanova's Online Learning with ElementK - contact the Help Desk x for an account.
Villanova's UNIT PC Refresh Site.

Chapter 7 : Microsoft Office Outlook - Free download and software reviews - CNET racedaydvl.com
Microsoft Outlook Â® for staff PC users. Microsoft Outlook Â® has been selected as the email client software to use
within the University.

Chapter 8 : How to Set Up Outlook to Send and Receive Email
Outlook has a robust calendar feature for managing your time and scheduling meetings with other NU users. Access the
Outlook Calendar Click on Calendar in the Navigation Pane.

Chapter 9 : Microsoft Office - Wikipedia
Help and support for the Microsoft Outlook app on PC, Mac, and mobile. Find how-to articles, watch video tutorials, and
get the most out of your Office subscription.
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